
EFFECTIVE MINDMAPPING USING MINDGENIUS

What is MindMapping?
MindMapping is a proven technique which unlocks the true potential of the brain.   MindMapping harnesses the full range
of cortical skills - words, images, numbers, logic, rhythm, colour and spatial awareness - in a single, uniquely powerful
manner. 
Typically MindMapping is used for note taking, generating/preparing communications, information gathering, gaining an
understanding, learning, people management, problem solving/solution generation, planning and strategic thinking.

Traditional Approach
Traditional MindMapping approaches use paper to graphically represent ideas and information.  Thoughts and ideas are
sketched around a key subject or idea in the form of branches, and areas of the resultant spider diagram (or map) are
colour-coded.

However, making changes to the map is problematic, as it has been produced on paper.   If changes are made, maps can
become complex and messy, particularly if they have also been passed around for review by others and everyone has
added their own thoughts and ideas onto the same map.  

Sometimes MindMapping is carried out in groups using flipcharts or whiteboards to draw a map that collates ideas from
the group.  This typically runs into many pages due to the limitation of the whiteboard/flipchart size.  These maps then
need to be properly interpreted and understood - an extremely arduous task that can take weeks to conclude.  

These problems, as we will show, are overcome totally with MindGenius.

How to MindMap using MindGenius
MindMapping with MindGenius is simple and straightforward, and allows you to follow Tony Buzan's mindmapping rules
to the letter.

All you need is a PC with MindGenius installed.

MindGenius electronic maps make it so much easier to manipulate and edit information, and you are no longer limited by
the size of your piece of paper.  

Some suggestions on how to mindmap with MindGenius, following Tony Buzan's mindmapping rules, can be found below:



Buzan MindMapping Rules
If you were to summarise Tony Buzan's mind mapping rules then you would get the following bullet points:

• Use blank paper
• Turn the paper sideways
• Start in the centre
• Make a colourful image of the topic
• Add the main themes

- One word or image
- Printed
- On an organic (or wavy) line
- Line is thicker towards the centre

• Branch off main themes
• Add second levels of thought
• Continue with third and fourth levels
• Incorporate

- Colour
- Symbols/Codes
- Arrows

• Outline or enclose branches
• Fill with beauty and have fun!

So let's look at these in turn and see how MindGenius can help improve your MindMapping capabilities.

Use blank paper
The normal default template for MindGenius has a plain background so as not to distract or interfere with the user's
thinking process. 

Turn the paper sideways
Fortunately, the screen on a PC has a landscape or sideways look. The MindGenius Map Editor window reflects this
sideways look.

Make a colourful image of the main topic
When MindGenius first opens a new map it requests you
to enter the topic title. To start a new map:

1. Select        from the toolbar
2. Type in the title of the map, this will be the title
of your mindmap
3. Press 'OK' or return

For this example, we would type in "MindMapping Rules" which will
overwrite the  text 'Untitled Map' and set the root branch of the map
to 'MindMapping Rules''

The next step is to insert a colourful image that represents the topic you are about to Mindmap. Remember the image
should have at least three colours and the act of generating and/or searching for a suitable image should have started
your thoughts flowing on the subject and started some right brain thinking. To add an image:



1. Select the root branch 'MindMapping Rules
2. From the Insert menu, select 'Picture…' 
3. Browse for a suitable image file to insert
4. Press 'OK' to insert the image into the branch.

Tip: The image was generated by importing some clip art images into PowerPoint, arranging

them, then saving them as a jpg file

If you wish, you can delete the Branch text and the picture will remain.

Tip: As individuals, images are personal. If you wish to share the map with others and make sure they understand the purpose/intent of the map, then add

a note to the root branch. To do this, select the root branch, open the Notes Tile in the Task Pane by selecting the         icon, and enter a text description.

The Note will be attached to the branch but the visual summary of the branch will be preserved - only the Notes symbol will appear on the branch. 

You can use this technique on any branch within your Mindmap.

Add the main themes
This couldn't be simpler with MindGenius. Select the root branch and use 'type-and-return' to add a new main theme. 

You can continue to 'type and return' and more child branches will be added to the parent branch, or simple select a
different parent branch to add child branches to.

Continue typing in the main themes 'LINES', 'WORDS', 'IMAGES' and 'COLOUR'.

The map will automatically restructure, leaving you to think. You can freely re-position the main themes by turning on Re-
position Mode (Select 'Re-Position Mode' from the View menu) and then dragging the branches to your chosen area in
the map.



Automatically Structured Re-Position Mode 

Tip: Do not reposition your branches until you have completed your map. This is a formatting rather than a content value adding activity. Let your map

automatically grow and flex. Don't interrupt your thinking process until you have to.

One word or image
You get what you type so it's up to you. In a Mind Map you will want to restrict the branch text to a single word as this
increases the 'ambiguity' of the branch and allows you to be more creative and encompassing in the child branches you
add. If you are communicating to people you may:

- Use multiple words
- Use single words to preserve the visual summary of the map whilst adding a note to the branch

Printed
Again you get what you type in. Set the CAPS LOCK on your keyboard.

On an organic (or wavy) line 
You get this automatically with MindGenius when the map default connector parameters are set to radial, tapered, and
curved (these settings can be accessed from the View menu).

Line is thicker towards the centre 
This is automatic with the tapered connector parameter set (default).

Branch off of main themes
Just use the 'type-and-return' text input method previously described. The map will simply grow in front of your very eyes,
for example:

Select 'WORDS' and ‘type and return' 'PRINT' then 'SIZE'
Select 'IMAGES' and 'type and return' 'CODES' then 'SYMBOLS'



Add second level of thought
Again just use the 'type-and-return' text input method previously described:

Select 'PRINT' and 'type and return' 'CLARITY' then 'CENTRAL' then 'OUTER'
Select 'SIZE' and 'type and return' 'EMPHASIS' then 'IMPORTANT'

Continue with third and fourth levels
Select 'CENTRAL' enter 'BIG'. Select 'OUTER' enter 'SMALL' then 'LITTLE'. Select 'SMALL', enter 'READABLE'.

Using the type and entry method, you can add as many levels as you wish. You are no longer limited by the size of paper,
only by your mind.



Incorporate Colour, Symbols/Codes, Arrows
Colour
MindGenius provides you with a wide range of colouring parameters so that you can change the look of branches.
Selecting 'Edit Branch Style…' from the Branch menu launches the 'Branch Appearance' dialog so you can change all
branch parameters.

There is also a quick method of changing the branch text colour and
branch shape fill using the primary (normally the left mouse button) and
secondary mouse buttons. 

1. Make the Colour Selector Tile visible
2. Select a branch to colour
3. A primary mouse click on a colour will apply that colour to 
the text. A secondary mouse click will apply the colour to the 
branch shape background 

Tip: If you wish to colour in multiple branches with similar colours, then use the Colour

Dropper       . In the Palette Tile set the foreground and background colours using primary

and secondary mouse clicks respectively. Press the colour dropper toolbar button to change

the cursor mode to 'Colour Dropper'. Use primary mouse clicks to apply foreground colour

and secondary mouse clicks to apply background colour. When finished, de-select the

dropper by clicking once more on the dropper icon in the Colour Selector Pane.



You can also vary the text font within the branch text. Double-click on the branch and the Edit Branch dialog will appear.
Simply select the part of the text you wish to change and edit it using the parameter controls provided.

Symbols/Codes
You can add Symbols/Codes to branches.

1. Open the Category tile in the Task pane by selecting the        icon at the bottom of the Task Pane
2. Select a branch
3. Double-click on a category to apply it to selected branches

Alternatively, the Dropper tool        can be used:

1. In the Category Tile, select the Dropper tool, the cursor will change to show it is in 'dropper' mode
2. Click on a category that you wish to apply
3. Click on branches with the dropper to apply that category

Once assigned, categories can be used as filter criteria and used to create a category map.

This is quick and easy to do and you don't have to rely on your memory to know what the Symbols/Codes mean.



Arrows
If you identify linkages across your map between seemingly disparate branches, you can record these in your map using
the MindGenius Mental Connection feature. To add a connection:

1. Click on the Mental Connection toolbar icon  
2. Click on the first branch then drag the mouse cursor to
the second branch and drop it. 
3. Enter a title for the Mental Connection when prompted
(if required)

Outline or enclose Branches
To highlight specific areas of the map you can enclose the Branches with a Boundary. TO do this:

1. Select a Parent Branch 
2. From the Boundary toolbar choose a Boundary Style to apply from the drop-down list
3. Set line and fill colours if required



Fill with beauty and have fun!
You can enter images and text throughout the map using MindGenius's Floating Text and Floating Pictures features. To
enter floating text:

1. From the Insert menu, select 
'Floating Text'
2. Click on the point in the map in 
which it should be inserted
3. Enter a title for the Floating Text
4. You can edit the text as if it was a
normal Branch.
5. It can be freely re-positioned 
using drag-and-drop

Enter a Floating Picture, by selecting 'Floating Picture' instead from the Insert menu. 

So MindGenius considerably simplifies your task of Mind Mapping



Example of a MindGenius Mind Map



And the extras you get?
MindGenius takes the MindMapping experience to new levels. Here are just some of the extra capabilities you get:

Map structure and hierarchy
The sequence and hierarchy of branches in relation to their parent branch are integral to the map and automatically
created as you add branches. The numbering system associated with this sequence/hierarchy can be made visible to aid
understanding.

Restructuring
The order in which your thoughts come out reflects your sequence of thinking and is often determined by the external
stimuli you experience. It may not best reflect how you wish your map to be structured. Simple drag and drop mouse
actions allow you to quickly re-arrange your thoughts.

Editing, adding, deleting
We all need to make changes. Use standard PC edit, add and delete actions. Your map simply flexes and grows/shrinks
to accommodate your changes.

Navigation
No matter how complex your map becomes,you can navigate your way around your map using MindGenius's Map
Explorer feature.
You can drill up, down and sideways. You can focus in on specific areas of your map. You are no longer constrained by
the size or complexity of your map.

It is also useful for performing 'walkthroughs' of your map.

Attachments
Any number of electronic files or hyperlinks can be assigned to a branch. These can be opened from within a map and
you have instant access to a host of supporting information and research.

Different views
Whilst the normal format of a MindMap is a 'circular' with its hierarchical structure extending outwards from the centre,
this is not always the best way to present the material. To make best use of screen space and to 'see'
linkages/connections between branches that cut across the hierarchical structure. At the click of a mouse you can
transpose your MindMap into the following diagram types with specific usages:

• Outline (list view)
• Input Tree (for identifying cause and effect)
• Output Tree (for examining what if scenarios)
• Affinity diagram (for grouping)
• Organogram (for hierarchical structures)

Test yourself
How well do you remember the contents of your MindMap? Use MindGenius's Levels and Expand/Collapse Branch
features to test your recall. Start at the core of the map. What are the Level 1 main branches? Did you get them right?
Expand the core to the next level and see. Pick a main branch. What are the next level of sub-branches… and so on. You
can use this technique to help plant the MindMap contents into your long-term memory.

Templates
You might find you have to regularly MindMap topics where the underlying framework is the same but the detailed content
is different. E.g. assessing an individual or problem situation. Save the framework as a Template and launch your map
using it to ensure that you cover the required areas. 



Styles
You can determine the look of your map as it is automatically generated. Each branch level has an associated 'Style'. You
can define the styles to be used for the complete map. If you decide to change the styles once you've created the map
you don't have to change all of the branches individually. Just go in and change the map style and the branches will adopt
the changes.

Filtering
You can filter on the Categories that you assign to the branches. If you assigned 'Highly Important' to a number of
branches in a complex map, you can set up a filter query so that you only see the 'Highly Important' branches.

Resources
You can assign resources to specific branches. Helps you identify who does what.

Actions
When used in conjunction with resources you can designate a branch as an action and assign it to a particular resource
(individual). You can then send the action request to the specified person via MS Outlook.

Creating new maps
MindGenius will automatically create a new map based on groupings of the category or resource codes that you assign
to the branches. View your map from a completely different perspective.

Reusable thinking
Save your maps for use and incorporation in future maps. How many times do you cover that same sub-topic in different
maps? You can save any branch (and its child branch structures) as a new map, either linked or independent from the
original source map. If the maps are linked, you only need to update one map for all of the maps that link to it to make
the updated information available to them.

Delivering in other formats
Your map can be exported into other applications to deliver it in the format that best meets the needs of the intended
audience.

Your maps can be converted into:
• Documents, reports (MS Word, pdf)
• Presentations (MS PowerPoint)
• Web pages (HTML)
• Project Plans (MS Project)
• Diagrams (Visio)
• Images (jpg, bmp, emf, png)
• XML for export to other applications



SUMMARY
MindGenius allows you to mind map in a highly effective way. 

With MindGenius you can produce true Mind Maps as Tony Buzan intended.

Not only that, but MindGenius overcomes the editing difficulties associated with Mind Maps produced on paper,
whiteboards or flip charts.

Remember that Mind Mapping is often only the first stage of completing a task or project, and that all the information
contained within your MindGenius Mind Map can be edited, analysed and transported into any number of different
applications, without having to re-enter the data.  

In this sense, your Mind Map is now a Work Map, and the thinking power generated can be harnessed and allowed to
produce action, productivity and results.


